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ETAMS Timekeeper Training tc "Course Outline"
COURSE OUTLINE

I.  FEDdesk Overview

A.  What Is FEDdesk?

B.  Why Use FEDdesk?

C.  ETAMS and Labor

D.  Two Week Pay Period Cycle 

· Current Pay Period Process

· Correction Process

· Amendment Process

X.  Job Responsibilities

XI.  ETAMS Timekeeper & Labor Clerk Schedule

XII.  Security and Program Access

A.  User ID, Password

B.  Program Access

C.  Record Access

V.  Base Schedules & Labor Default
A.  Establishing Base Schedules & Labor Default Schedules
B.  Signing Base Schedules

VI.  Timecards 

A.  Entering Timecard and Labor Data

B.  Signing Timecards

C.  Collecting Timecards

VII.  Payroll Corrections 

A.  Correcting Timecards & Amendments

B.  Reviewing Corrections 

C.  Clearing Corrections

VIII.  Amendments

A.  Entering Amendments

B.  Signing Amendments

C.  Collecting Amendments

IX.  Other Options

A.  History Archives & Archives Search
B.  ETAMS & Labor Reports

X.  Hands On Practice

A.  Entering Base Schedules & Labor Default Schedules
B.  Entering Timecards & Labor Data
C.  Entering Amendments

FEDDESK OVERVIEW tc "FEDdesk Overview"
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TIMEKEEPER RESPONSIBILITIEStc "Timekeeper Responsibilities"
The ETAMS Timekeeper is responsible for maintaining ETAMS Base Schedules and preparing and completing Timecards. Some Timekeepers are also Labor Clerks and are responsible for completing the Labor record for the Pay Period.  After Timecards and Labor records are complete, the Timekeeper is responsible for obtaining signatures on all records before the scheduled collection time.

ETAMS tasks to be performed each Pay Period:

1.  Add new person into the ETAMS Base Schedule.

2.  Enter a Labor Default Schedule.

3.  Resolve with the National Payroll Center any ETAMS record that is not validated.

4.  Obtain Signatures for Base Schedules.

5.  Complete Timecards and Labor records for the Pay Period.

6.  Obtain Signatures for all unsigned records.

7.  Verify that Timecards are ready for collection before the deadline.

8.  Complete Amendments.

9.  Obtain Signatures for Amendments.

10.  Review Corrections and ‘Complete’ the Review.

All of the above tasks must be performed on scheduled days in accordance with the existing Pay Period schedule.

ETAMS tasks to be performed as required:

1.  Process records when someone leaves the Facility.

2.  Delete records when they are no longer needed.

3.  Submit changes to Timecards and Labor records (Amendments) as needed.

4.  Resolve rejected Timecards (Payroll Corrections) with payroll as soon as possible.

Report Problems and Questions to:
ETAMS Facility Coordinator

Skills required to perform these tasks:

1.  Working knowledge of current forms and Timekeeping procedures.

2.  Familiarity with Internet access to FEDdesk.

Suggested training:


· Completion of the ETAMS Timekeeper training course.

Suggestions for Timekeeper appointments:

1.  It is recommended that persons with minimal travel responsibilities handle FC and Timekeeper duties.  ETAMS tasks must be performed on a set schedule.  If the ETAMS person is not available to perform a specific task at the appointed time, backup persons must have enough experience to perform the tasks.

2.  It is best to have one Timekeeper for every 30-50 Timecards.  Fewer people involved in Timekeeping procedures will keep the Facility running smoothly.

3.  The Timekeeper and the alternate should rotate responsibilities so that both people are up to date with current Timekeeping procedures.

ETAMS TIMEKEEPER & LABOR CLERK SCHEDULEtc "Timekeeper & Labor Clerk Schedule"                                                                 April 2006
	WEEK 1

SUNDAY
	MONDAY
	TUESDAY
	WEDNESDAY
	THURSDAY
	EFT PAYDAY

FRIDAY
	SATURDAY

	ETAMS Lockout 

3:30AM – 5:30AM CST 

Timecards & Labor Records Are Created Today for the New Pay Period 

(See Note 11)

Hawaii Exception 

(See Note 3b)
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	ETAMS Lockout 

1:30PM – 4:00PM CST 

Timecards & Labor Records Are Collected Today for Last Pay Period (See Note 11)

BEFORE  1:00PM CST

Timecards

(See Notes 2, 3, 4, 5, 6, 7, 9 & 13)
1. Complete Timecards 

2. Complete Labor Records

3. Obtain Signatures


	
	
	12:30AM – 3:00AM CST

Processed Timecards and Amendments are moved to History

ETAMS Lockout 

3:30AM – 5:30AM CST 

Payroll Corrections & Leave Balance Data are Returned Today (See Note 11)
ANYTIME

Payroll Corrections

 (See Note 10)

Review Payroll Corrections

Leave Balances

Review Leave Balances on Timecard
	 
	

	WEEK 2

SUNDAY
	MONDAY
	TUESDAY
	OFFICIAL PAYDAY

WEDNESDAY
	THURSDAY
	FRIDAY
	SATURDAY
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	Base Schedules

(See Notes 4, 12)
Add, Modify, Obtain Signatures


	


NOTES FOR THE ETAMS TIMEKEEPER & LABOR CLERK SCHEDULE 

March 2007
· All Times shown here are Central Standard Time (CST).

· For detailed instructions on any of these procedures, refer to the ‘How to’ section in on-line Help.

· Some Facilities do not have the Labor feature enabled and therefore do not have Labor records.

1.  Data Entry:
(a)  Timecard and Labor data can be entered every day of the Pay Period.

(b) Amendments can be entered every day of the Pay Period.  However, Amendments for last Pay Period cannot be created until the 1st Thursday, which is after Timecards for last Pay Period have been moved to History.  

2.  The deadline for completion of Timecards and Labor records is 1:00PM CST on Monday (Week 1).  For exceptions, see Note 3  

3.  Exceptions to completion and collection of Timecards and Labor records: 

b) Holiday - When there is a Holiday on Monday (Week 1), the deadline for completion of Timecards is 1:00PM CST on Tuesday.  The rest of this schedule is the same.

c) Hawaii - Hawaii Facilities must have Timecards and Labor records ready for collection by COB on Sunday, Week 1.

4.  Only signed records are collected.  If a Timecard is not signed before the ETAMS lockout, the signed Base Schedule and Labor Default is collected in lieu of the Timecard.  The unsigned Timecard and Labor record then become an Amendment.  If neither the Base Schedule nor Timecard is signed, the person has no Timecard or Labor record picked up for the Pay Period.  When an Amendment is not Signed at collection time, it stays in the Amendment file and is not collected until it is signed.

5.  Labor records are not signed, but they are linked to the Timecard for the same Pay Period and cannot be picked-up without a signed Timecard/Amendment.

6.  Signed Timecards and Amendments that are modified, become unsigned.  These records must then be re-certified.

7.  Timecards can be Reviewed and Signed anytime BEFORE the deadline.  Contact the Certifier when records are ready for Signature.

8.  Amendments can be entered daily and are collected daily after normal business hours.  Amendments are not processed until the 2nd week of the Pay Period.  Amendments for last Pay Period cannot be entered until Thursday after the Timecard for the same Pay Period has been collected.  Amendments for last Pay Period will not be collected until the first Friday of the new Pay Period.  This means that an Amendment adjustment for last Pay Period will not show up on the upcoming Pay and Leave Statement.

9.  When someone leaves your ETAMS Facility or the Agency, follow instructions given in on-line help to ‘Process an Employee Leaving the Facility or Agency’.  

10.  Payroll Corrections are changes made by the Payroll Office to Timecards or Amendments that are rejected during processing.  The Timekeeper and the Certifier should review the changes.   If any Payroll Correction is in error, an Amendment should be submitted.

11.  During collection access to ETAMS is blocked.  Lockout times are approximate.

12.  Add/Modify Base Schedules & Labor Defaults before COB on the 2nd FRIDAY of the Pay Period to have the additions/changes in effect for next Pay Period.

13.  When a name appears on the ‘Employees Not Validated’ Report, their records cannot be signed and therefore cannot be collected.
IMPORTANT ETAMS REMINDERStc "Important ETAMS Reminders"
1. To access FEDdesk, always start from the FEDdesk System home page (http://feddesk.gsa.gov).  This page alerts you to problems that arise, new program enhancements, and necessary changes that have been made.

2. New Base Schedules and Labor records and changes to Base Schedules and Labor records must be made NO LATER THAN COB on the 2nd Friday of the Pay Period in order to have the changes in effect for next Pay Period.

3. SSNs that are not validated cannot be certified and therefore cannot be collected.

4. Base Schedules should be signed at all times.

5. There are 4 reasons why a Base Schedule signature is automatically removed:

a. Pay Status change 

b. Tour of Duty change (Full-Time to Part-Time & visa versa)

c. Name Change by a Personnel action

d. Name Discrepancy:  When an employee’s first and last name in ETAMS does not match exactly the first and last name in PAR, the ETAMS Base Schedule is automatically unsigned. 

Unsigned Base Schedules should be reviewed by the Timekeeper and then re-certified.

6. Timecards should be signed no later than 1:00 PM (CST), the first Monday after the end of the Pay Period. 

7. Unsigned Timecards (that have a signed Base Schedule) are sent to Amendments at pick-up time and replaced with the signed Base Schedule.

8. If both the Timecard and Base Schedule are unsigned, no record for the person is picked-up for the Pay Period and the unsigned Timecard is NOT moved to Amendments.

9. Amendments can be entered daily and are collected daily after normal business hours but are not processed until the 2nd week of the Pay Period (Monday, Thursday and Sunday).  Amendments for last Pay Period, however, cannot be entered until Thursday after the Timecard has been collected.   Amendments for last Pay Period will not be collected until the first Friday of the new Pay Period.  This means that an Amendment adjustment for last Pay Period will not show up on the Pay and Leave Statement for 2 Pay Periods.
10. Payroll Corrections should be reviewed by both the Timekeeper and the Certifier.

11. Passwords must be changed every 90 days.  You are notified at log on when this is needed.  Check the on-line help for ‘Changing Your Password’. 

LOGGING ON AND OFF FEDDESK/ETAMStc "Logging On and Off FEDdesk/ETAMS"
The FEDdesk Application is accessed via the Internet.  Use this procedure for logging on and logging off.

To Logon to FEDdesk/ETAMS:

1. Double click on your browser icon (Explorer, Navigator, etc.) to access the Internet. 

2. Place your cursor at the beginning of the address field and enter the location of the FEDdesk System Home page:  http://feddesk.gsa.gov/.  Press the Enter key.  Wait for connection.
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3. From the FEDdesk System home page, single click the System Logon tab. (If you are a first-time user, a browser plugin will automatically download. 
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4. From the OCFO Web Applications ‘Log in’ window, enter your User name /UserID and press the Tab key.

5. Enter your Password and press the Enter key or click ‘Log in’.
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6. From the Applications window, click on the FEDdesk icon to open the application.  A warning message alerts you about connecting to a government computer.  Read and accept the warning by clicking OK. 
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7. From the FEDdesk Menu, single click on Time and Attendance (ETAMS).

Items that are not available to the User are grayed out.

Note:  If the FEDdesk application has been inactive for 15 minutes, you will automatically be disconnected.

To Logoff ETAMS/FEDdesk:

To log off the FEDdesk system, perform the following steps:

1. From any ETAMS screen, select the File Menu and then Exit.  Repeat this until the FEDdesk Menu displays.  

2. From the FEDdesk Menu, click the Exit FEDdesk.

3. From the OCFO Web Applications window select another application or click Log Off and return to Windows.

Note:  The recommended ‘exit’ procedure is not to use the ‘X’ in right corner of the screen, especially from the FEDdesk Menu.  

Note:  If the FEDdesk application has been inactive for 15 minutes, you will automatically be disconnected.

CHANGING YOUR PASSWORDtc "Changing Your Password"
Use one of these procedures to change your FEDdesk Password.  

Change Password from the GSA OCFO Applications Gateway
Use this procedure to change your Password from the GSA Applications Gateway.

1. After log on to the GSA Applications Gateway, click on the key icon to display the ‘Change Password’ screen.
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2. Enter your Old Password.  Press the Tab key.

3. Enter your new Password and then enter the new Password again for confirmation and click OK.  A confirmation message is returned when the Password change has been successfully completed.

Note:
Password Criteria is found on the FEDdesk System web site (http://feddesk.gsa.gov).  Click on the Help tab and then go to Password Criteria.

Note:
After changing your Password wait 30 minutes for updates to take effect before logging on again.

Note:
If you forget your Password, contact your Facility Coordinator.  The Facility Coordinator will set your Password back to a default to allow entry into FEDdesk.

Note:
You can also change your Password from the FEDdesk Menu by clicking on Change Password.

Change Password from FEDdesk

Use this procedure to change your FEDdesk Password from the FEDdesk Menu:

1. Click Change Password to display the ‘Change Password’ screen.

2. Enter your New Password.  

3. Press the Tab key.  Enter your new Password again and click OK.  A confirmation message is returned when the Password change has been successfully completed.

Note:
Password Criteria is found on the FEDdesk System web site (http://feddesk.gsa.gov).  Click on the Help tab and then go to Password Criteria.

Note:
After changing your Password wait 30 minutes for updates to take effect before logging on again.

Note:
If you forget your Password, contact your Facility Coordinator.  The Facility Coordinator will set your Password back to a default to allow entry into FEDdesk.

Note:
You can also change your Password from the OCFO Applications Gateway by clicking on the key icon. 

LOGON SYSTEM MESSAGEStc "Logon System Messages"
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EXCEPTION CODEStc " Exception Codes"
To display available Exception Codes, place your mouse pointer in any Code or Hrs column on the following screens and click the right mouse button:  Timecards, Amendments, Base Schedules.  Only the appropriate codes that are valid on the record type will display.

00
Regular Day Off (X)
01
Regular Scheduled Hours

02
Holiday Observed

07
FLSA Hours Worked

09
Make Up Hours Before OT

10
Regular Scheduled OT

11
Holiday Worked

12
Sunday Premium

13
Comp. Time Earned

14
Irregular Scheduled OT

15
Call Back OT

16
Travel Comp Time Earned

17
OT Rotating Shift

20
Second Shift Night Diff

22
EDP Act. Expose / OT 4%

23
EDP Act. Expose / OT 6%

24
EDP Act. Expose / OT 25%

25
EDP Act. Expose / OT 50%

26
EDP Act. Expose / OT 8%

27
FFL - Family

28
FFL - Funeral

29
FFL - Adoption

30
Third Shift Night Diff

31
Federal Disaster Relief

32
Federal Disaster Relief

33
Evacuation Pay

34
Furlough Regular

35
Furlough Lack of Funds

36
Credit Hours Earned

37
Credit Hours Used

38
Federal Disaster Relief – Non-Reimbursable
39
FFL – Serious Health Condition Family Member
40
Annual Leave

41
Comp. Time Used

42
Court Leave

43
Travel Comp Time Used

44
Restored Leave #1
45
Restored Leave #2

46
Religious Comp Earned

47
Religious Comp Used

48
Home Leave

49
Military Reserve Technicians


50
Sick Leave

51
Regular. Military

52
Law Enforcement Military

53
DC Nat Guard Military

54
Award Leave Used

55
Furlough (Over 30 Days)

56
Lack of Funds (Over 30 Days)

57
FMLA - Family

58
FMLA - Employee

59
Suspension

60
LWOP

61
AWOL

62
Actual Exposure - 4%

63
Actual Exposure - 6%

64
Actual Exposure - 25%

65
Actual Exposure - 50%

66
Hours In Pay Status - 4%

67
Hours In Pay Status - 8%

68
Hours In Pay Status - 25%

70
Union-Term Negotiations

71
Union-Mid-Term Negotiations

72
Union-Dispute Resolutions

73
Union-Gen Labor/Mgt Relations

80
Volunteer Leave

81
COP Used #1

82
COP Used #2

83
COP Used #3

84
Other Paid Absences

85
Donated Leave Used

87
LWOP Workman's Comp Used
90
Telework-Periodic/Intermittent

91
Telework-Short Term

92
Telework-Long Term

93
Telecommuting Center

TIME CALCULATIONS
tc "Time Calculations"
Throughout ETAMS (timecards and labor records), time is expressed as hours and tenths of an hour.  
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The following Business Rules are used for all fields where time is entered:

· Time is expressed in the format: hh.t where h = 0 – 24 and t = 0 - 9.

· Minutes are expressed as tenths of an hour (1 tenth hour = 6 minutes).

· Minutes are truncated to one decimal place (no rounding).

· Entries may need to be adjusted due to rounding. (eg. 15 min of leave = .2, but one hour of leave in 4, 15-minute increments = .2, .2, .3, .3 = 1 hour).

Use the following chart to record minutes as tenths of an hour.  

	PRIVATE 
MINUTES
	TENTHS OF AN HOUR

	0   -   5
	0

	6   -  11
	1

	12  -  17
	2

	18  -  23
	3

	24  -  29
	4

	30  -  35
	5

	36  -  41
	6

	42  -  47
	7

	48  -  53
	8

	54  -  59
	9


Examples:
Timecard / Labor Entry
Actual Hours/Minutes



.7  or  0.7

 42 - 47 minutes




3  or  3.0

 3 hours




.2  or  0.2

 12 – 17 minutes




5.5


 5 hours and 30 - 35 minutes




7.2


 7 hours and 12 - 17 minutes




9.7


 9 hours and 42 - 47 minutes

SHOW START/STOP TIMES
tc "Show Start/Stop Times”
Note: START/STOP TIMES should be used only when directed by your Agency/Organization.

By default, the ETAMS Timecard (including Base Schedule, Amendment, History and Payroll Correction) displays only an Hrs (Hours) column for recording time.  Time is recorded in hours and tenths of an hour both for Regular Scheduled Hours and Exception time.  

Timecard hours can also be entered in 24 hour format using a Start time and a Stop time for Regular Scheduled Hours and Exception time.  
From the ETAMS Timecard (or Base Schedule or Amendment) click in the Show Start/Stop box to display the Start and Stop columns.  Uncheck the Show Start/Stop box to hide the columns.
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The display changes to show a Start column and a Stop column between each Code and Hrs column.
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After adding an entry in a Code column enter a Start and a Stop time.  Tab out of the Stop field to display the entered time in the Hrs column.

To disregard all Start/Stop times, uncheck the Show Start/Stop box and revert back to the default screen.

Rules to remember when using Start/Stop times:

*
Time must be entered in 24 hour format (hhmm) where hh = 00 – 24 and mm = 00 – 59.

*
Only actual hours worked is entered as Regular Scheduled Hours.  Do not include lunch break.

*
For every Start time, there must be a Stop time.

*
Start/Stop times and Hrs (hh.t) can both be used on the same timecard.

*
Meal time hours cannot be included as part of Regular Scheduled Hours or exception hours.

*
After entering a valid Start and Stop time tab out of the field.  The Hrs column displays the equivalent time in Hours and tenths of an hour.

*
If more than 3 exception codes are needed for any day, click in the Show Supplemental box.  A new row displays for each day of the pay period that allows entry of an additional 3 codes.

*
After entering and saving Start/Stop times, the default screen for the record shows Start/Stop times the next time the record displays.  

*
If Start/Stop times have been entered, unchecking the Show Start/Stop box will display a message that asks if you want to hide the Start/Stop columns and revert back to the normal view.  If you click OK to this message, all entered Start/Stop times are lost and cannot be retrieved.  Click the Cancel key to keep the format of the screen as it currently displays.

*
Start/Stop times entered on the timecard will NOT display on the Labor Detail screen.  

*
Start/Stop times entered on the Labor Detail screen will NOT display on the timecard.

Use the following chart to record the correct 24-hour format for Start/Stop Times.  Standard Times are listed along with the corresponding 24-Hour time.

	PRIVATE 
STANDARD TIME
	24 HOUR TIME

	12:01   AM
	0001   HOURS

	1:00   AM
	0100   HOURS

	2:00   AM
	0200   HOURS

	3:00   AM
	0300   HOURS

	4:00   AM
	0400   HOURS

	5:00   AM
	0500   HOURS

	6:00   AM
	0600   HOURS

	7:00   AM
	0700   HOURS

	8:00   AM
	0800   HOURS

	9:00   AM
	0900   HOURS

	10:00   AM
	1000   HOURS

	11:00   AM
	1100   HOURS

	12:00  NOON
	1200   HOURS

	1:00   PM
	1300   HOURS

	2:00   PM
	1400   HOURS

	3:00   PM
	1500   HOURS

	4:00   PM
	1600   HOURS

	5:00   PM
	1700   HOURS

	6:00   PM
	1800   HOURS

	7:00   PM
	1900   HOURS

	8:00   PM
	2000   HOURS

	9:00   PM
	2100   HOURS

	10:00   PM
	2200   HOURS

	11:00   PM
	2300   HOURS

	12:00   PM
	Either 0000 HOURS (Start Time)

Or     2400 HOURS (Stop Time)


Examples
Standard Time 
24 Hour Time


        5:15 AM

  0515  HOURS



        2:30 PM

  1430  HOURS



      10:45 PM

  2245  HOURS


SHOW SUPPLEMENTAL CHECKBOX
tc " Show Supplemental Checkbox "
The default view of a timecard displays seven columns for entering Exception Codes EXCEPT when Start/Stop Times are used.  Once the ‘Show Start/Stop’ checkbox is checked, the screen expands and can only display three columns for entering Exception Codes.  
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The ‘Show Supplemental’ checkbox is locked until the ‘Show Start/Stop’ checkbox is checked.  When more than three Exception Codes are needed for any given day, check the ‘Show Supplemental’ box to expand the record and display an extra row for each day of the Pay Period.  Now, up to six Exception Codes can be entered for each day of the Pay Period.  Uncheck the ‘Show Supplemental’ checkbox to go back to the default view.
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To access the Supplemental rows:

1. If you are using the Start/Stop columns to enter hours, after making 3 entries on any day of the Timecard or Amendment and more room is needed to enter additional entries for the day, click in the ‘Show Supplemental’ checkbox field found in the upper right corner of the screen.  An extra row displays for each day of the Pay Period.

2. Scroll down to find a day that is filled all the way across.  

3. Enter the next Code directly under the day that is completely filled.  Start in the first gray ‘Code’ field on the blank line under the selected day.  

4. When the Supplemental entries are complete, Close out of the screen and the entries are saved.  When you display the record again, the Supplemental rows are visible.  The box under the ‘Show Supplemental’ checkbox now displays ‘Supplemental’.
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PROCESSING PERSONS LEAVING THE FACILITYtc "Processing Persons Leaving the Facility"
Use one of these two procedures to complete the last Timecard submitted for someone leaving the ETAMS Facility.

(1) A person moves from one ETAMS Facility to another ETAMS Facility within the Agency.
1. Complete the Timecard for the entire Pay Period, as usual.

2. ONLY ONE TIMECARD CAN BE SUBMITTED FOR A PERSON EACH PAY PERIOD. If the person is leaving in the middle of the Pay Period, contact the gaining Facility to find out the work schedule of the person for the remainder of the Pay Period.  Timekeepers from the gaining and losing Facilities must be in agreement as to when the losing Facility will send in the last Timecard for the Pay Period and when the gaining Facility will enter the first Timecard for the Pay Period.

3. Enter a ‘Remark’ on the Timecard to indicate the move from one Facility to another.

4. Have the Timecard signed and ready for collection as scheduled.

5. Check Timecards, ‘All Pay Periods’ to see if there are any FUTURE Timecards for the person that is not needed.  These future Timecards must be deleted.  With the future Timecard on the screen, select the File Menu and then select ‘Delete Timecard’.

6. Go to the Base Schedule and change the status of the person from ‘Active’ to ‘Inactive’. 

Note:  The Inactive status allows the records (Base Schedule, History) to be picked up by the gaining Facility, and, the Inactive status will not generate new Timecards.

Note:  Persons with Amendments cannot be made ‘Inactive’ until all Amendments have been collected.  Signed Amendments are collected daily, after normal business hours.

7. Contact the gaining Facility to make sure that the person is entered into their Base Schedule, with a status of ‘Active’, ready for the next Pay Period.

Note: After the gaining Facility has added the new Base Schedule, the Base Schedule in the losing Facility is automatically deleted.

(2) A person leaves the Agency because of retirement, separation, death, or moving to another Agency.

1. Complete the Timecard for the entire Pay Period, as usual.  Change the Separated Indicator (Sep Ind) from ‘No’ to ‘Yes’ to inform the Payroll Office know that this is the last Timecard for the employee. 

2. Enter a ‘Remark’ on the Timecard to note the last work-day (i.e. ‘Separated as of COB MM/DD/YY’, where the date is the last working day).

3. If the person is leaving in the middle of the Pay Period, enter a 00 (X) code for EVERY day of the tour that is not worked. 

4. Have the Timecard signed and ready for collection as scheduled.

5. Check Timecards, ‘All Pay Periods’ to see if there are any FUTURE Timecards.  These future Timecards must be deleted.  With the future Timecard on the screen, select the File Menu and then select ‘Delete Timecard’.

6. Verify that there are no Payroll Corrections for the person.  If so, Review and take action.

7. Verify that there are no Amendments for the person waiting to be collected.  If so, contact the Certifier immediately so that the amendment can be collected tonight.

8. Go to the Base Schedule and change the status of the person from ‘Active’ to ‘Inactive’.

Note:  The Inactive status allows the records (Base Schedule, History) to be picked up by another Agency, and, the Inactive status will not generate new Timecards.

Note:  Persons with Amendments cannot be made ‘Inactive’ until all Amendments have been collected.  Signed Amendments are collected daily, after normal business hours.

9. In case of retirement, separation or death, ‘Delete’ the Base Schedule only after the person’s records are no longer needed.

ADDING AN AMENDMENTtc "Adding an Amendment"
An Amendment is a Timecard from a previous Pay Period that needs modification.  Amendments can be entered every day.  Signed records are collected every night but are not processed until the 2nd week of the Pay Period.  
Amendments for last Pay Period cannot be added until the first Thursday of the new Pay Period and will not be collected until the first Friday of the new Pay Period.  This means that an Amendment adjustment for last Pay Period will not show up on the upcoming Pay and Leave Statement.

Perform the following steps to add an Amendment.

1. From the ETAMS Main Menu, click on Amendments.  The Select screen shows all the Amendments currently on file.

2. From the ‘List’ box, click the ‘Base Schedule’ radio button.  The Base Schedule list of names displays.

Note:  Alternately, click in the ‘SSN’ field in the upper center portion of the screen.  Enter the SSN.   Go to step 4 in this procedure.

3. Click once on the Name for whom you want to create an Amendment.

4. Select the Year and PP (Pay Period) number in the upper center portion of the screen, by clicking on the down arrow, to display the appropriate Year and Pay Period number for the Amendment.

5. Click OK.  A message displays to tell you that the Amendment does not exist and asks if you want to add it.

6. Click Yes if the SSN, Name, and Pay Period/Year displayed are correct.  One of  three scenarios occurs:

· If the Amendment is for last Pay Period and it is Tuesday or Wednesday of the 1st week of the new Pay Period, a message displays: ‘Amendments for this Pay Period cannot be added until Thursday.’  Wait until Thursday to add the Amendment.

· If the Amendment is for someone who has a History record for the Pay Period, the Timecard displays.  Make any needed changes to the record.

  (OR)

· If the Amendment is for someone who has no History record for the specified Pay Period, a blank Timecard displays.  Complete the entire Timecard, including the Regular Tour of Duty, any transactions that were originally submitted, plus any changes or additions that need to be submitted.

Note:  To delete an Amendment, after displaying the record, select File, Delete Amendment.

7. Enter a ‘Remark’ to inform Payroll and the Certifier as to why this Amendment was needed.

8. When all Amendments are entered, notify the Certifier.  Signed Amendments are collected daily, after normal business hours.  Amendments for last Pay Period are not collected until the first Friday of the new Pay Period and every night after that.  

ADDING A NEW PERSON tc "Adding a New Person "
To add a new person to ETAMS, perform the following steps:

1. From the ETAMS Main Menu, click on Base Schedules.  Either 

· click in the SSN field, enter their SSN and click OK,  

or 

· if the name is listed but has not been assigned an Area/Team, highlight the name and click the ‘OK’.

2. Respond ‘Yes’ to the question asking if you want to add a Base Schedule.  If the new person is not in the Payroll system an additional message displays.  The message asks if the person is a Government Associate or a Contractor.  If you select ‘Government Associate’ you are required to reenter the SSN.  Next, a blank Base Schedule record displays.  Fill in the appropriate information across the top and down the right side of the screen: Name, Status, Block Number, Area/Team, Tour of Duty (Full-time/Part-time/Intermittent), AWS, and labor information if applicable.  Then fill in the appropriate hours on the left hand side of the record.  (For complete information see ‘How to Add a Base Schedule Record’ in the ETAMS online Help.)

3. When the Base Schedule record is complete, notify the certifier and ask them to sign the record. 

Note:  Labor facilities receive a message that the Labor Default schedule must be completed.  For complete information see ‘How to Setup a Labor Default in the ETAMS online Help.

Note:  If the new person is already validated in PAR, the Tour Indicator (Full/Part field) is view only and cannot be changed.  If the new person is a non-validated government employee or a Contractor, the Tour Indicator is open for selection.

To manually create the person’s Timecard for the current Pay Period, perform the following steps:

Note:  If the new Base Schedule record is established before the new Pay Period records are created, the Timecard is automatically created at the time of initialization.  Perform these steps only when the new Base Schedule record is entered after the Pay Period records have been created.

1. From the ETAMS Main Menu, click on Timecards.

2. From the ‘Timecard Select’ screen, go to the ‘List’ box located in the upper right portion of the screen and click the Base Schedule radio button.  The Base Schedule list of names displays.  

Note:  Alternately, click in the ‘SSN’ field and enter the SSN.  Go to step 7.

3. Click once on the Name you wish to add.

4. Go to the ‘View’ box and click Timecards Only.

5. Go to the ‘Period’ field and click the down arrow.  Highlight the Pay Period number for which the Timecard is to be created.  (The Pay Period number should now display in the ‘Period’ field.)

6. Click the ‘OK’ button.  The message “Timecard does not exist.  Do you want to add it?” displays.

7. Click Yes.  The information from the Base Schedule is copied to create a Timecard for the current  PP. 

8. If needed, make any “exception” changes to the record.

9. If changes were made and signature removed, when completed notify the Certifier for Signature.

Note:  This procedure is only required when the record is either not in the Base Schedule or the status of the record is changed from ‘Inactive’ to ‘Active’ after the automatic initialization of the new Pay Period takes place.  Once an ‘Active’ record is in the Base Schedule, the Initialization process will automatically create the new Timecard from now on.

ETAMS SCREENStc "ETAMS Screens"
FEDdesk Menu
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ETAMS Main Menu 
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ETAMS SCREENS

Base Schedule – Base Schedule Select
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Base Schedule –Detail
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ETAMS SCREENS

Timecards – Timecard Select
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ETAMS SCREENS

Amendments – Amendment Select
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Amendments –Detail
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ETAMS SCREENS

Payroll Corrections – Payroll Correction Select
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Payroll Corrections –Detail

[image: image22.png]Privacy Data PLO3-579 Privacy Act - ETAMS - Payroll Correction o x|
Y T
v
" [10[ao]a2[s50[51[>€| Period [205 2| Area [15 Team [54 e
sosao% s el - Ll Lo Db B B LT L
saoeme 2we for[ @0 Jozfss [ [ [ I ] =
saveme ot forfes fofms [ [ [ I ] BT
soame awe for[e0 fofms [ [ [ I ] Tavcom
sseme s [or[ 60 faof 88 farfas [ [ [ ] e
soozos 6Fr for[ 88 [ | T [T [T [T [T cresth
sz 7sa | [ [T T T T [T AsaE
snzo0s  asu o [T [T [T [T [T [T Fsfs
soee e forfes [ [T [ C— [ O o —
sooses tomu foxfee [ [ [ [ [ [ [ [ [ ] e —
swme e forfEs [ [T [ C— [ O festee
ssme vzm forfes [ [ [ [ [ [ [ [] il
swame vare foxfes [ [ [ [ [ [ [ [ [ []
orame vwsa e[ [ [ [T [T [T T Tour e





ETAMS SCREEN FOR START/STOP AND SUPPLEMENTAL ENTRIEStc "ETAMS Start/Stop & Supplemental Screens"
Timecards are saved the way they are closed.  If a timecard is closed after a Start/Stop entry is made, the record stays that way for later viewing.  If you uncheck the Show Start/Stop box and then close the record, the Start/Stop entries are lost.

Timecard expanded to show Start/Stop columns.
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Start/Stop Timecard expanded to show Supplemental row.
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ETAMS LABOR SCREENStc "ETAMS Labor Screens"



LABOR REPORTStc "Labor Reports"
All Labor records (Labor Default, Labor Summary, Labor Detail, and Labor Favorites) can be printed for a specific person to whom the Timekeeper has access.  Summary reports can also be printed for specific Areas/Teams to report Craft Code, Labor Summary and Labor Default information.  And, two reports can be printed to list Invalid Labor Default Schedules for anyone to which the Timekeeper has access.

Invalid Labor Default Reports can be accessed from either the Base Schedule or Timecard Select screen.  From the Reports Menu, select Labor Default – Invalid.  
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Select one of two available reports.
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(1) Persons that have no Labor Default Schedule
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(2) Persons that have Invalid/Inactive codes on the Labor Default Schedule
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Run these reports periodically and correct any invalid Labor Default schedules.

History Archives and ARCHIVES SEARCHtc "Archives"
History Archives and Archives Search offers a way to view and print ETAMS historical records.   All records processed by Payroll for the Pay Period (i.e. Timecard, Payroll Correction, Amendment), can be viewed.  Select a name from a list (Archive Select) or enter an SSN (Archives Search) to display a complete list of archive records for one person.  Records are stored indefinitely and move to another ETAMS Facility whenever someone moves.  
History Archives
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Select History Archives from the ETAMS Main Menu.  
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Click on a name and then click ‘OK’ to display the list of archived records.  You may also limit your search by entering a specific Year and Pay Period or choosing a specific type of record (i.e. Amendments, Corrections).  
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Click on the specific Pay Period record to either print or view. 

Archives Search

Archives Search is accessed from the File menu on the ETAMS Main Menu.  After entry of a valid SSN, click ‘OK’ to display a list of all records found.  
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Highlight the record to view and click ‘OK’.
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ETAMS Reportstc "ETAMS Reports"
ETAMS reports are accessed from the ETAMS Main Menu.  Report information is generated from current Pay Period information and ETAMS History Archives records.


Exception Code Report

The Exception Code Report provides information about one specific Exception Code found on current or historical timecards for one or more persons.  Search criteria includes Start / End Date, Leave Type Code (or any Exception Code), and an SSN or Area/Team number.
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Individual Exception Code Report 

To generate an Individual Exception Code Report, enter a Start and End Date for the report and the SSN.

The Individual Exception Code Report lists all Exception Codes entered on a timecard for a specified period of time.  At the top of the report, data displays by Pay Period and day.
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At the bottom of the report, the total amount of time charged to each Exception Code displays.

Supervisor’s T&A Certification Report
The Supervisor’s T&A Certification Report gives the Supervisor the results of the Pay Period processing.  The displayed records are based upon the logged on user’s permissions.  Records are available to a Supervisor who has signed either the employee’s Base Schedule or Timecard for the selected Pay Period.  The Supervisor certifies the data shown on the report for each Pay Period.
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Timekeeper Report
The Timekeeper Report displays the results of the Pay Period processing for the selected date.  The displayed records are based upon the logged on user’s permissions.  Records are available to any Timekeeper who has permissions to access the Area and Team records shown for the selected Facility.  This report is view only.
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ETAMS Timekeeper Exercise tc "Hands On Practice"
This exercise begins on Monday morning of a new Pay Period.  The Pay Period just ended (13) has not been collected and new Pay Period timecards (14) are ready for entry.  

1.  Log in to the LAN:

2.  Access FEDdesk and the ETAMS program. 

3.  Log in to ETAMS.



UserID:   FEDUSER____           Password:   Pass1word
Facility Select: _________

 Area:   ____  ____  /  Team:   ____  ____   

4.  Base Schedules:  Add 3 new Government employees

Enter Base Schedules for Employees A, B, and C.  Use Social Security numbers on the list provided FOR YOUR AREA.  For Employee B ONLY, use the SSN ending in either 0 or 1.  For all other entries, us an SSN ending in 2 – 9 ONLY.  Change the employee name so that the LAST name begins with the letter A (Employee A), B (Employee B) and C (Employee C).  Enter Base Schedules using the information given.  (If your employees normally work second/third shift, and are entitled to Night Shift Differential or Sunday Premium, add this to the Base Schedule.)

Base Schedule information must include Name (LName FName), Block Number, Area/Team, Status (Active or Inactive), AWS Code (Y or N), and (Full Time / Part Time / Intermittent).  Use the same Area/Team assignment for all of your entries.  Leave the Sep Ind (Separated Indicator) ‘N’ or blank.  Enter the schedule and put an entry on each line.  Use a code 00 (displays as X) for each non-working day of the tour.

Employee A:
SSN _________________________  (ending in 2 – 9) 

Name _____________________________________ Full Time:  Standard Tour or Flex Schedule. Use 080H to indicate an 8-hour workday, Monday - Friday.  Use code 00 (X) for Saturdays and Sundays. 

Employee B:
SSN __________________________  (must end in 0),

Name _____________________________________ Part-Time:  8-hour days, Monday, Wednesday, And Friday for both weeks.  All other days are coded as non-working days (use code 00 [X]).

Employee C:
SSN ___________________________ (ending in 2 – 9) 

Name _____________________________________ Full Time:  5/4-9 Schedule.  Use 080H & 090H code.  Eight-hour day is first Monday.  AWS day off  (use code 00 [X]) is 2nd Monday.  All other workdays are 9-hour (090H) days.

5. Labor Default Schedules:  Enter Labor Default schedules for all new persons.  From the Base Schedule, 

a. Set up Favorites

b. Set up a Labor Default schedule.

6. Base Schedules will be Reviewed and Signed.  

7. Create Timecards for the current Pay Period for each new person.
a) From the Main Menu, go to Timecards.  At the Timecard Select screen,

b) Go to the List box and click ‘Base Schedule’.

c) Go to the View box and click ‘Timecards only.

d) Go to the Period window and select Pay Period 14  (current Pay Period) IF it does not display.

e) Find and double click on your new name.  A message says ‘Timecard does not exist.  Do you want to add it?’  Click ‘Yes’.

f) Close out of the screen and repeat steps b, c and d for all your new employees.

Note:  This procedure is followed only when a new Base Schedule is entered AFTER the Pay Period records have already been created.  After the first Pay Period, Timecards are created automatically for all records that are in the Base Schedule.

Note:  If you have the labor feature, each time you select a Timecard you will get a message asking if you want to complete the Labor Default schedule.  Complete the Labor Default OR to bypass the Labor Default temporarily, each time you come to the ‘Timecard Select’ screen go to the View box and click ‘Timecards Only’.  Then find your record.

Note:  If you create a Timecard for the wrong Pay Period or for the wrong person, display the Timecard and from the File Menu select Delete Timecard.  Then, repeat the add procedure.

8. Complete Timecards - Make the following entries on the Timecard for Employee A, B, C.

Employee A

A-1.
On the first Tuesday the person took 2 hours of Annual Leave. 

A-2.
On the first Wednesday the person was on Sick Leave all day.

A-3.
On the second Tuesday, the person took 5 ½ hours of Annual Leave and took Sick Leave for the rest of the day.

A-4.
Employee A was 15 minutes late coming to work on the second Wednesday.  Supervisor did not approve leave.  Leave needs to be charged as AWOL.

Employee B

B-1.
On the first Tuesday, the person worked an additional 2 hours and 15 minutes.  (Hint:  This is NOT overtime because the person is not working a 40-hour week.  Change the Regular Tour from 00 (X) to the number of hours worked.)

B-2.
Employee B is Separating from the Agency.  The last day of employment is the first Friday of this PP.  (Hint:  For each day not on duty, the Regular Hours column must have a 00 (X) code.  The Sep Ind (Separated Indicator) should be changed from an ‘N’ to a ‘Y’.  Remember to add a Remark on the Timecard (‘Emp separating as of COB MM/DD/YY’.  (See Page 18.)

Employee C

C-1.
Employee C earned 5 hours and 30 min. of Comp Time the first Saturday of the PP and used this Comp Time on the second Friday. 

C-2.
On the 2nd Thursday, the person took 2 hours of Sick Leave, 3 hours of Annual Leave, 2 hours of Comp Leave and LWOP for the rest of the day.  (Hint:  You will need to use the Supp page for part of your entries.)

9. Add a New employee:  Use an SSN on the list for your Area.  Change the name with a last name beginning with D.).

a) 
Employee D:
SSN ____________________(ending in 2 – 9) 


Name ____________________________________ Add a new Full Time person to the Base Schedule with an AWS (5/4/9) Schedule.  8-hour day is the first Friday.  AWS day off  (use code 00 [X]) is the 2nd Monday.  All other workdays are 9-hour days.  Create a Timecard for this person.  (See Page 20 in the Timekeeper manual)

b)
Create a Labor Default schedule for this person.

d) On the second Wednesday Employee D was on LWOP for 4 ½ hours.

10. Labor Summary - Make the following modifications to these Labor Summary records.

a.)
Change the Labor Summary for Employee D  -  The person spent the 1st week of the PP (Mon – Fri) on a Project that is different from the Labor Default Schedule.  The hours worked on the timecard remain the same.  How many hours did the employee spend on this project? _________

Note:  Sometimes it is necessary to adjust the ‘Hours logged’ total on the Labor Summary so that the ‘Hours Remaining’ field is ‘0’.

b.)
Change the Labor Summary for Employee C  –  The person spent the first week of the PP on a different project.  How many hours did the employee spend on this project?  ________

11. Certifier will Review and Sign Base Schedules and Timecards.

12. Amendments (See ‘How to’ procedure in manual, Page 19.)

a) Add one Amendment for Employee A for last PP to include 4 ½ hours of Comp Time Earned on the first Saturday.  In the Remarks section, enter an explanation of any changes made.

b) Add one Amendment for Employee C for last Pay Period to include LWOP for the remainder of the workday (after using Comp Leave for 5 hours and 30 minutes) on the second Friday.  In the Remarks section, enter an explanation of any changes made.

c) Add an Amendment for Employee B for last PP.  Change the Labor Code(s) from the Labor Default to another project for the total hours worked during the Pay Period.  The Timecard is not changed.  In the Remarks section, enter an explanation of any changes made.

13. Certifier will Review and Sign Amendments.

After Amendments have been Reviewed and Signed, verify that ALL Amendments in the Area are ready for collection.

COURSE REVIEWtc "Course Review"
Name:________________________________________________        Date:______________________

Match the ETAMS task in Column A with the person(s) responsible for the task in column B.  Options in Column B can be used more than once.



Column A






Column B

	1. _______   Add Base Schedules.
	T.  Timekeeper



	2. _______   Review Corrections.
	F.   Facility Coordinator



	3. _______   Change a person’s status from Active to Inactive.


	C.   Certifier



	4. _______   Enter Timecard data.
	

	5. _______   Enter Amendment data.
	

	6. _______   Review and Sign Timecards.
	

	7. _______   Separate an person.
	


Circle the correct underlined response.

8. To display a complete list of available Exception Codes, click the    right,    left    mouse button.

9. Fields in aqua are    display only  /  data entry    fields.

10. When an person has left the Facility and has moved to another Organization / Facility, enter a Status Code of    Active / Inactive    on the Base Schedule       before,    after    the new Pay Period has been Initialized.

11. Explain these Time Codes:

0.3 _____________________________________________________________________________

2.0 _____________________________________________________________________________

4.8 _____________________________________________________________________________

12. What is the Time Code (expressed in hours and tenths of hours) for:

Nine Hours  ______________________________________________________________________

Fifteen Minutes____________________________________________________________________

Two hours and thirty minutes_________________________________________________________

T (True) or F (False)       

13. ______
Payroll Corrections are records that ‘errored out’ during payroll processing and were corrected by payroll.

14. ______
Timecards can be Reviewed, Signed, and ready for collection earlier than the deadline.

15. ______
All Base Schedules should have an entry on each day of the 14 day tour.

16. ______
A Labor Default schedule is like a Base Schedule: Everyone must have one. 
17. ______
If someone’s Timecard is not signed at collection, then the signed Base Schedule record will replace the Timecard.

18. ______
When the signed Base Schedule replaces the Timecard, the uncollected Timecard is deleted.

19. ______
The default view of a timecard/base schedule/amendment shows Hours and tenths of hours but the view can be expanded to show Start/Stop times.

20. ______
Any Amendments not signed at collection will be deleted and must be re-entered.

21. ______
The ‘Complete Review’ option removes the nag screen.

22. ______
Amendments must be Signed before they will be picked up. 

23. ______
An Amendment record should have a Remark to explain the Amendment entry.

24. ______
When you are making changes to someone’s Timecard AND Labor Summary record, ALWAYS change the Timecard first and then change the Labor Summary. 

25. ______
Amendments are collected daily but are only processed during the 2nd week of the Pay Period (Tuesday, Thursday and Sunday). 

26. ______
You will not know if your Timecards have been Signed unless the Certifier contacts you.

27. ______
The Separated Indicator (Sep Ind) should be set to a ‘Y’ on the last Timecard submitted for a person moving from one ETAMS Facility to another ETAMS Facility
28. ______
The Separated Indicator (Sep Ind) should be set to a ‘Y’ on the last Timecard submitted for someone leaving the Agency.

29.  What is your Facility ID?  ____________________

30.  Who is your Facility Coordinator?  ____________________________________________________.

31.  Who is your Facility Coordinator backup?  __________________________________________________
COURSE EVALUATION tc "Course Evaluation"
Course Title:
FEDdesk/ETAMS TIMEKEEPER TRAINING 

Date ______________________
    Location _________________________________________

Instructor(s) ___________________________________________________________________

Please mark your response to the statements below using these codes:


1 - Poor





4 - Above Average


2 - Needs Improvement

5 - Very Good


3 - Satisfactory 



6 - Excellent

Course Content
_______ 1.
The course was well organized.

_______ 2.
The topics discussed held my attention.

_______ 3.
Class time was used effectively.

_______ 4.
The course outline was easy to follow.

_______ 5.
The course materials were helpful.

_______ 6.
The material covered was relevant to my duties.

_______ 7.
The course material was presented at a level that I understood.

Job Performance
_______ 8.
This course has increased my knowledge of Timekeeping procedures.

_______ 9.
I feel comfortable with ETAMS now that I have attended this course.

Instructor Evaluation
_______10.
The instructor was well organized.

_______11.
The instructor was knowledgeable about the topic.

_______12.
The instructor communicated ideas effectively.

_______13.
The instructor was available for questions.

Please comment on each question below.

14.  Which topic(s) would you like to have discussed in more detail?

15.  What were the strong points of the class?

16.  What were the weak points of the class?







Amendments are collected daily but are not processed until the second week of the Pay Period.   (See Notes 4, 5, 6 & 8)
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Unsigned Amendments Report


This report displays at logon if there are Amendments that are currently not certified.  Amendments are collected daily, but only signed Amendments can be collected.





Action to be taken:  Review the Amendment.  Delete the record or contact the certifier to have the record signed.
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Timecards, Labor Data & Amendments can be entered daily.    (See Note 1)











The 02 – Holiday Observed code is automatically inserted on the timecard and Labor record (if applicable) for the holiday if the holiday falls on a work day.  Do nothing on the timecard if the holiday is taken as shown.  Move as needed for the ‘In lieu of holiday’ taken.  AN OFFICIAL HOLIDAY IS AUTOMATICALLY CALCULATED IN PAR.  THIS CODE IS FOR DISPLAY ONLY AND IS ALSO USED IN CALCULATING PRODUCTIVE TIME IN LABOR FACILITIES.





Amendments are collected daily but are not processed until the second week of the Pay Period    (See Notes 4, 5, 6 & 8)








Timecards, Labor Data & Amendments can be entered daily.    (See Note 1)








Unsigned Base Report


This report displays at logon if there are unsigned Base Schedules in any Area/Teams to which you have access.





Action to be taken:  Contact the Certifier to have the records signed immediately.  The signed Base Schedule is the replacement timecard if the timecard is not signed at collection.





Employees Not Validated


This report displays at logon if there are Government employee SSNs in the Base Schedule that are not found in the Payroll System.  Contractors are not validated.  In addition, the last known timekeeper is also sent an email re the unvalidated SSN.  When an SSN is not validated, neither the Base Schedule nor the timecard can be certified and therefore cannot be collected.





Action to be taken:  Contact the Payroll Office immediately to determine if the SSN is correct.  The Payroll Office will help you resolve the problem with each record.





Payroll Corrections to Review Report


This report displays at logon if there are timecards or amendments that were corrected by Payroll after collection.





Action to be taken:  Review all Payroll Corrections for which you are responsible.  If OK, no action is needed.  If the correction is not accurate, an amendment must be entered to correct the Payroll Correction.





Note:  These messages display for all ETAMS users.  It is the responsibility of the Timekeeper to take action so that the name is removed from the list.  ETAMS Users with Signature permissions will also get an ‘Uncertified Supervisor’s Reports’ nag screen when appropriate.  





Labor Favorites


A list of ‘Favorite’ codes selected from the complete list of Facility Project codes can be set up for each labor associate.  Place your mouse pointer in the ‘Favorite’ box on the left side of the screen and right click to display a pop-up window.  Drag a Project from the ‘All’ column to the ‘Favorite’ column on the left side of the pop-up box.  Setting up a list of Favorites is optional.  Either the timekeeper or the labor associate can set up the list and the list can be modified at any time.





Labor Default


A Labor Default schedule must be set up for each employee.  A Labor Default defines the type of work the employee normally engages in during the Pay Period.  One or more Project/Task combinations can be defined.  The total work time (entered as a percentage or hours) must be equal to the number of hours in the 2-week tour.  The default is then copied to the Labor Summary each Pay Period and may be changed as needed.








Labor Summary


The Labor Summary is the record that is collected each Pay Period that summarizes the type of work performed by the employee.  Projects and Tasks and the amount of time spent in each activity are recorded.  The Labor Summary can be the same as the default, or it is changed to reflect the employee’s specific work for the Pay Period.  When changes are needed, always complete the timecard first and then make any necessary changes to the Labor Summary.
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